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ANSYS ICEMCFD 5.1 
使用手册 

1. ANSYS ICEMCFD图形用户界面 

ANSYS ICEMCFD网格编辑器的标准化图形用户界面，提供了一个完善的划分和编辑数

值计算网格的环境。 
另外，自从ANSYS ICEM CFD 将相应的CAD模型（同样可以生成和编辑）与网格划分

链接起来以后，网格编辑器允许用户在修改CAD模型后快速再生成新的网格。对于为一个

模型生成的网格可以被再次链接到一个新的CAD模型上，节约了重新划分网格的时间。 
网格编辑器界面包括三个窗口： 
ANSYS ICEM CFD 主窗口 
模型的树状目录 
ANSYS ICEM CFD 信息窗口 

1.1：ANSYS ICEM CFD 主窗口 
除了图形显示区，在它的上部设置了一排按钮提供操作菜单，这些菜单包括： 

几何，网格，块，网格编辑，输出和post processing工具。 
窗口的右上角有一串功能菜单，它们与以上这些菜单的选择无关。 
文件：文件菜单提供许多与文件管理相关的功能，如：打开文件、保存文件、合并和输

入几何模型、存档工程，这些功能方便了管理ANSYS ICEM CFD工程。 
 在这个菜单里有用的功能包括：新建工程、打开工程、保存工程、另存为、关闭工程、

改变工作地址、几何菜单、网格属性、参数、结果、输入几何模型、输入网、输出几何模

型和退出。 
带有特殊标记的功能按钮包含有子菜单，可以通过点击看到。 
编辑：菜单包括回退、前进、命令行、网格转换小面结构、小面结构转化为网格、结构

化模型面。 
视图：菜单包括合适窗口、放大、俯视、仰视、左视、右视、前视、后视、等角视、视

图控制、保存视图、背景设置、镜像与复制、注释、加标记、清除标记、网格截面剖视。 
信息：菜单包括几何信息、面的面积、最大截面积、曲线长度、网格信息、单元体信息、

节点信息、位置、距离、角度、变量、分区文件、网格报告。 
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设置：菜单包括常规、求解七、显示、选择、内存、远程、速度、重启、网格划分。 
帮助：启动帮助、启动用户指南、启动使用手册、启动安装指南、有关法律。 
 
 
(a)几何菜单 

几何菜单包括编辑、修改几何图形的功能。 

功能及作用： 

生成点、生成/修改线、生成/修改面、生成体、修改几何图形、转化图形、删除点、删

除线、删除面、删除体积点及删除实体。 

(b)网格菜单 

网格菜单包括 ANSYS ICEM CFD 网格工具的模块。 
以下按钮可以导入不同 ANSYS ICEM CFD 支持和开发的网格划分模块。 
设置全局网格尺寸、设置表面网格尺寸、设置曲线网格尺寸、创建加密区、创建单元、

表面网格、四面体、金字塔、六面体（旧界面）、六面体分区网格及拖拽网格。 
点击这些按钮调用网格工具模块。 

(c)块操作菜单 

创建块、分割块、合并顶点、编辑块、对应、移动顶点、块转换、编辑边、前期网格参

数、前期网格质量、块检查、删除块。 

(d)编辑网格菜单 

编辑网格菜单包括高级网格编辑必需的工具：粗化、平滑、合并网格。 

通过这个菜单可执行的操作包括： 

创建单元、创建中间节点、网格检查、计算和显示质量、平滑全局网格、平滑六面体网

格、修改网格、合并节点、分割网格、移动节点、偏移网格、转化网格、网格类型转化、

调整网格密度、重新编号网格、网格重新自适应、删除中间节点、删除节点及删除单元。 

(e)输出菜单 

输出菜单通过装配求解器、写求解器输入文件、启动求解器来控制边界条件的编辑。输

出菜单包括以下几个功能键： 

选择求解器、边界条件、编辑参数、写输入文件。 

图标功能菜单： 

打开工程、保存工程、打开几何文件、打开属性文件（定义在几何体中的边界条件）、

打开块文件、适合窗口、放大、测距离、当地坐标系、刷新。 

回退：还原到上一步操作 

前进：重返到下一步操作 

框架显示：使几何图形显示框架状视图 

阴影显示：使几何图形固体（不透明）显示 

 

1.2：模型目录树 

位于屏幕左侧的模型目录树，通过部分、几何实体、单元类型和用户定义的子集控制图

形显示。 

因为有些功能只对显示的实体发生作用，所以目录树在孤立需要修改的特殊实体时体现

了重要性。 

部分： 



颜色标记和用户定义显示。 

几何体： 

通过几何实体右边的选择框，用户对按钮选择可视模式控制显示。 

1.3：消息窗口 

消息窗口包括所有ANSYS ICEM CFD写出的信息来使用户了解内部过程。窗口显示操

作界面和几何、网格功能的联系。在操作过程中时刻注意消息窗口是很重要的，它将告诉

用户进程的状态。 

保存命令将所有窗口内容写入一个文件在工程打开的地方。 

日志选择按钮选中状态时只将保存用户特定的消息。 

注意日志文件与通过保存命令得到的文件比较的独特性。这个文件写入工程打开的地方

并可以更新记录的消息，当被选择关闭后，用户可以继续加入这个文件同通过再次激活且

接受相同的默认文件名，它可重新附加在工程上。 

 

2. 六面体网格工具（hexa） 
ANSYS ICEM CFD 是一个三维基体、半自动、多块结构和非结构、表面和网格生成工

具。 
2.1：介绍 

ANSYS ICEM CFD 块工具代表了一种生成六面体网格的新途径。块拓扑模型在几何主

要框架下直接生成，在一个友好界面下这些通常的专业操作也可以很容易因为自动化的特

点而被接受。 
ANSYS ICEM CFD 被认为是市场上最快的六面体网格生成工具，用户可以针对航空航

天、汽车业、计算机和化工应用在相比传统工具很少的时间内生成高质量的网格。 
在使用ANSYS ICEM CFD 生成网格过程中用户可以访问两种类型实体，块拓扑结构和

几何体。在生成了一个与几何体相当的拓扑模型后，拓扑块可以通过分割边、面、块改进。

此外，可以用在相关联的曲线或表面上单独或者成组移动块顶点的功能。用户也可以通过

使特定的块边与几何体曲线相关联在网格中捕获重要的几何特征。 
而且，对于可以利用对称性的情况，用户可以通过拓扑变化实现，如：平移、旋转、

镜像、比例。简单的快拓扑概念使得块结构快速生成和操作，并最终很快的实现六面体网

格产生。 
ANSYS ICEM CFD 的块操作提供一个以基于映射的网格生成环境，默认的情况下在不

同体之间所有块的平面与贴近他们的几何表面相关联，在同一个体的块的平面也可以与定

义的为内部壁面的指定几何表面相关联。一般来说，没有必要操作使所有的平面与主要几

何表面相关联，这就大大减少了网格生成的困难。 
ANSYS ICEM CFD 块操作的特点： 
自动O网格：对于非常复杂的几何体，ANSYS ICEM CFD 的块操作自动生成适应体的

内部或外部O网格来参数化地使块拓扑适合几何体以保证好的网格质量。 
边划分参数：六面体的边划分参数使用户特定的系列化要求具有无限的弹性。 
随时保存办法：ANSYS ICEM CFD 块操作在网格生成中提供了随时保存表面的平滑和

体的改进运算。 
网格细化/粗化：网格的细化或者粗化允许用户在不同的梯度的地方对任何一个块区域

分别指定一个更细或者更粗的网格定义。 



命令流：命令文件记录功能使得参数化的块拓扑生成能同样链接于以改变尺寸的几何

体。 
对称性：在分析旋转机械的应用中是必要的，例如：六面体网格工具允许用户利用对称

性针对旋转机械的一部分划分网格，最小化了模型尺寸。 
形状关联：这个特性使用户可以将边的形状关联与已存在变形的边，更好的控制网格尤

其在参数化的研究。 
适应性：选择通过三维体网格生成三维表面网格，二维向三维的块拓扑转化。 

2.1.1： ANSYS ICEM CFD 块操作生成网格 
利用ANSYS ICEM CFD 块操作生成网格用户可以通过所有的直接、间接或者小面数据

接口输入几何文件。 
反复通过分割、合并、O网格定义、边/平面修改和顶点移动这些功能来特定块模型。 
检查块的质量以保证块模型达到指定的质量限度。 
边的划分参数赋值,如：最大单元尺寸、边界处单元初始高度、扩张率。 
利用或者不利用定义映射参数来生成网格。检查网格质量以保证达到特定的网格质量标

准。 
为期望的求解器写输出文件。 
用户有必要随时可以返回以前的操作步处理块模型，如果网格质量不能达到指定的界限

或者网格没有捕获某些几何特征。块操作在任何时候能够被保存，这就允许用户返回到前

期的块拓扑。 
另外，在此过程中的任意一步，用户能运用各种映射方案生成网格，如：全部面映射、

边映射、点映射或者完全没有映射。 
在没有映射的情况下，将在块模型的平面上生成网格，可以快速的发现此时的块方案是

否多余或者是否必须修改。 
2.1.2块结构的数据基元  

ANSYS ICEM CFD 的块结构数据单元既包含几何也包含块拓扑数据，它们又分别包含

若干子实体。 
几何数据实体： 
点：由x、y、z、坐标定义的点 
曲线：有理B样条曲线 
表面：NURBS曲面 
块拓扑结构数据实体： 
顶点：块的顶点，至少有八个来定义一个块 
边：一个平面有四个边而一个块有十二个 
平面：六个平面构成一个块 
块：由顶点、边、平面构成的体 

1.1.3：ANSYS ICEM CFD 块结构的智能几何 
用支持参数化描述CAD模型和网格生成过程的ANSYS ICEM CFD 直接CAD接口，能够

容易地在修改的几何体上再生成六面体网格。 
在CAD体系中选择的几何体被标记带有网格生成信息（智能进行），如：边界条件、网

格尺寸，而且这种智能几何信息被保存在主要几何体中。 
在块操作中，通过更新映射的功能更新所有实体，映射到几何体指定点的块顶点自动适



应参数的改变，用户可以快速重新计算网格。此外，利用命令流的功能，ANSYS ICEM CFD 
提供了完全的路径重现前期操作。 
1.1.4：非结构和多块结构网格 

ANSYS ICEM CFD 的网格输出可以是非结构或者多块结构的，而且直到用户已经完成

了全部的网格划分过程进行输出选择时才决定。 
非结构网格输出： 
非结构网格输出的选择将产生单个网格输出文件，所有属于块交界面上共有的节点是合

并的，独立于模型中块的数目。 
多块结构网格输出： 
提供给能够识别多块结构网格的求解器，多块结构网格输出的选择将产生一个输出文

件，包含在拓扑模型中的每一个块。 
例如：一个块模型有五十五个块，那么在根目录中将产生五十五个输出文件。 
此外，块输出选择允许用户最小化在多块结构法中输出文件的数目而没有合并块与块交

界面上的任何节点。 
1.1.5：块结构方案 

使用ANSYS ICEM CFD ，不论模型多么复杂生成一个六面体模型的必要基础操作是相

同的。当初始块拓扑结构生成后，接下来就可以通过分割合并块或者利用称作O网格（见

下一节）的操作来修改。在这些对于块的直接操作完成时，也可以通过变化块子实体（例

如：顶点、边、平面）来间接修改。 
初始化，hexa创建一个包含所有实体的块。接下来进行的块菜单改进对对应于几何体的

块模型的操作，可以在单个块或者若干块间作用。 
注意：ANSYS ICEM CFD的拓扑结构实体用颜色来区别不同的属性。 
边的颜色： 
白色的边和顶点： 
这些边位于不同的材料体间，它们和被关联的顶点将被映射到这些材料体中最贴近的

CAD表面，而且这些边上的顶点只能在表面内移动。 
蓝色的边和顶点： 
这些边位于体内部。它们的顶点也是蓝色的，可以在选择之前沿边拖拽。 
绿色的边和顶点： 
这些边和关联的顶点是映射到曲线的，这些顶点只能在它所映射的曲线上移动。  
红色的顶点： 
这些顶点是映射到指定的点的。 
分割 
对选择的块应用分割功能，既可以作用于这个块，也可以分别通过运用边切割或者面切

割选项作用于块的一个单独的面或者边。块可以利用目索引控制来孤立显示。 
合并 
合并功能与块切割工作工程类似，用户既可以合并整个块也可以合并块的一个面或者

边。 
当一些模型生成块拓扑结构时对块技术要比较高的要求时，hexa的块工具能使用户迅速

掌握一个复杂的块模型生成。 
1.1.6 O网格的使用 



O 网格生成技术是从一个或多个块衍生出如下五个子块拓扑结构。对于基础 O 网格生

成有若干参数，下面的例子是在所选的块内部产生： 

    
初始块              O 网格                 包含一个面的 O 网格 

利用加入面的选项，可以使生成的 O 网格穿过被选择块的一个面。在上面第三幅图中，

应用加入右侧面的命令选项来生成 O 网格。  
自动 O 网格的另一个重要特点是可以在生成以后重新修改它的尺寸。在最初生成 O 网

格时，其尺寸是根据 O 网格参数窗口的一个因子而确定的。用户可以利用这个功能在 O 网

格生成后重新定义它的尺寸。 
通过移动其顶点和定义平面、边、定点与几何体之间的关系，块结构也可以被修改。 

1.1.7 ANSYS ICEM CFD 图形用户界面 
实体显示控制： 
在树型目录下用户可以控制以下每一个实体显示。例如用户可能希望只有曲线在屏幕上

显示而不显示表面，这时便可关闭曲面只保留曲面被激活显示。鼠标右键单击各类实体名

称将会弹出一系列的功能选项。如果用户想观察一个网格的节点或者是节点的编号，右键

单击网格(mesh)然后选择节点(dot node)或者节点编号(node number)。这些显示的图标使

ANSYS ICEM CFD 的适应性在各种不同模式下得到体现。 
扫描截面： 
利用这项功能，用户可以选择显示一个模型的内部或者外部边界的平面网格。如果这个

网格还没有生成，hexa 将在扫描界面控制窗口显示之前首先计算网格。在一个网格受到几

何或者是批法则的限制时此功能可以用来检查内部体网格的质量。 
映射选项： 
当块操作完成而且用户想要重新计算网格时，可以有各种映射选择，通过在块（目录树）

下右键单击预生成网格(pre-mesh)得到，分为：无映射，顶点映射、边映射和平面映射。如

果是在网格划分过程的开始阶段或者是想快速预览网格，无映射选项将是可取的。如果模

型完成后而且准备要输出到求解器，这时，边映射和面映射通常分别应用到二维和三维模

型中。 
面的部分： 
在面部分列表中有用户定义确定输入的 CAD 数据的显示。有时将点、曲线、表面定义

在各自的部分里来使显示有条理。实体通过部分、构成、区域可以更进一步的被区分开。 
曲面、曲线和点的详细信息： 
当选择曲面(surface)>显示曲面名称(show surface name)时，曲面的名称将在曲面的主体

下方显示，列出不同的曲面各自的名称。曲线和点实体也可以在同样的模式下显示名称。

为了更清楚地显示利用详细信息列表分别隐藏部分里曲面、曲线和点是很方便。 



VORFN： 
VORFN 组是一个部分，它是默认就存在的，尤其在用户想要删除某个区域时比较有用。

为了输出而删除一个块等价于将这个块定义在部分列表 VORFN 里，只有在树型目录里被

激活的边才可以被输出。 
Blanking（透视）： 
在块的编号变的十分混乱的时候，需要进行这项操作选择某些块是否透视。 
Index Control（标号控制）： 
利用块的标号控制可以允许用户只对可视的块模型进行修改。ANSYS ICEM CFD 主要

依据笛卡儿坐标 I、J、K 作为标号来描述块的位置，当一个 O 网格生成以后，就会加入一

个指示标号，在 ANSYS ICEM CFD 的消息窗口也将显示有关的信息，告知用户块的维数。 
注意 ： O 网格的维数从 O3 开始计，3 代表了维 0，1 和 2，分别被预先定义为 I，J 和

K。 
使用图形窗口模式： 
系统提供两个模式来决定鼠标在图形窗口的作用：动态模式和选择模式。除了用户在

Hexa 的提示下要求选择一个实体而进入选择模式的情况外，动态模式都是激活状态。 
在相应的模式下，鼠标按键有以下作用： 
动态模式： 
左键左右移动将旋转模型绕屏幕的 y 轴旋转，上下移动将绕 x 轴旋转。旋转的中心是模

型上最接近光标的位置的点。 
移动中键将按照鼠标拖得程度来平移模型。 
右键上下移动将分别实现放大和缩小，而左右移动将使模型绕屏幕 z 轴顺时针、逆时针

旋转。 
操作中的动态模式： 
如果操作过程需要用鼠标进行一个屏幕的输入，这时用户也可以按 F9 优先使鼠标转为

动态模式。F9 键也可以允许鼠标从动态模式下返回继续选择模式。 
选择模式： 
左键用来选择一个或多个实体。  
单击中键来完成选择。 
右键可以用来奖赏一个选择的实体移出选择或者在没有任何选择的情况下来取消操作。 
连续选择功能（在这种情况下，用户可以在一个实体上完成一个操作的选择接着选择不

同的实体，而不用退出选择模式）鼠标是选择模式。在图形窗口底部的消息窗口里将用红

色的文字提示下一部操作。  

3. Hexa 附录 
ICEM CFD Hexa 在生成大型、高精度三维几何体的六面体网格上已经表现为最快速、

最全面的软件。目前最新版本的 ICEM CFD Hexa 也可以用同样的速度和适应性生成三维

体的表面网格。 
3.1.1：块模型的最重要特点 

CAD 和基于映射生成六面体网格； 
三维体拓扑模型的简易操作； 
新颖的图形界面和利用最新六面体网格技术的软件构造； 
自动 O 网格生成和尺寸再定义； 



基于几何体的网格尺寸、边界条件定义； 
网格优化提供足够的网格尺寸在梯度高低不同的区域； 
光滑和松弛运算快速得到高质量的网格； 
多块结构、非结构和 super-domain 网格的生成； 
特定的周期说明功能； 
全面的重造功能，无需用户对参数的研究； 
块的边之间链接关系自动完成边的划分； 
诸如：平移、旋转、镜像、比例等拓扑操作功能容易地生成拓扑模型； 
三维体拓扑块到三维表面网格拓扑自动转化； 
二维拓扑块到三维拓扑块自动转化； 
对于初始或最终网格计算的多种映射选择； 
基于行列式、内角和体积的质量检查； 
区域内拓扑块的重新编号； 
输出块的定义减少多块结构网格输出文件的数目； 
块方位和原点的修正选项。 

3.1.2：自动 O 网格的生成 
用以达到一个高质量的网格，生成 O 网格是一个非常强大、快速的技术，如果没有 O

网格的存在这将是不太可能的。用户可以应用 O 网格生成环形体的网格，也可以对于一个

几何模型环绕一个部分或者整个几何体做 O 型网格。  
O 网格的重要特征： 
生成垂直于物体边界的正交网格线； 
O 网格生成是完全自动化的，用户选择能容易地选择块，在所选块的内部或者外部生成

O 网格，可以被完全包含在选择的区域内，也可以通过选择块的某些面； 
O 网格生成后尺寸的再定义： 
当一个 O 网格生成后，它的尺寸是由 Blocking>O-grid 参数菜单下的因子确定的，用户

可以利用 Blocking>Re-scale O-grid 中的选项修改 O 网格的尺寸。如果这个值小于 1，得到

的 O 网格将比初始的小，同理，大于 1 的值将得到较大的 O 网格。 
3.1.3：边的划分参数 
边的划分参数定义是由特定划分需求的自适应性自动提供给用户。在拓扑块模型优化完成

以后就是边的划分参数赋值，通过选择Meshing > Edge params得到。 
用户可以选择以下划分的法则： 
默认的Bi-Geometric Law 
Uniform 
Hyperbolic（双曲线） 
Poisson（泊松） 
Curvature（曲率） 
Geometric 1 
Geometric 2 
Exponential 1 
Exponential 2 
Bi-Exponential 
Linear 



Spline 
在Hexa里用户可以通过Meshing > Edge Params >Graphs option修改这些存在的定义边划

分的法则。 
可以选择的有： 
Constant 
Ramp 
S curve 
Parabola Middle 
Parabola Ends 
Exponential 
Gaussian（高斯法则） 
Linear 
Spline 
注意：通过选择这个选项，可以添加、删除、修改那些用来调节边的参数设置的控制点，

另一种工具，如边划分链接和多次复制选项，提供给用户迅速在整个模型中应用指定边的

划分参数的方法。 
3.1.4：平滑技术 

在ICEM CFD Hexa中，拓扑块和网格都可以进行平滑来提高一个区域或者整个模型的全

部块和网格的质量。在网格生成之前可以平滑拓扑块以改进它的形状。这个技术减少了修

改拓扑块模型所需的时间。 
在进行拓扑块的平滑时几何构成和它所关联的平面、边、顶点全部被固定。在拓扑块的

平滑完成，设置边的划分参数后，用户就可以对网格进行平滑。 
平滑的准则： 
Determinant（行列式）：通过在影射和几何的限制下移动节点来试图提高单元的行列式

值。 
Laplace（拉普拉斯）：通过移动节点最小化网格线的突变。 
Warp（弯曲度）：这种方法是基于修改两个单元之间差的角。 
质量：和行列式准则一样，质量准则通过重新配置受几何和影射限制的节点来提高单元

的内角。 
Orthogonality（正交性）：以提供模型边界正交网格线为目的。 
Skewss（倾斜度）：体和表面的倾斜度定义是不同的。对于一个体单元，这个值是通过

计算所有的相邻面的法线得到的，获得的最大值标准化，所以0表示正交的面而1表示平行

的面。对于表面单元，是通过首先计算面的短对角线与张对角线之比，然后减1获得倾斜度， 
0表示完全的矩形，1表示最大的倾斜度。 
3.1.5：细化与粗化 

在Meshing >Refinement,找到细化功能菜单，可以获得一个更细密或者更粗化的结果。

细化和粗化可以被用来同步地在三个方向或者只在一个方向上进行。 
细化： 
细化功能针对可以识别匹配块边界非正形投影节点的求解器，在高梯度的关键区域最小

化模型尺寸达到合适的网格定义。 
粗化： 
在流动特性对模型网格定义要求比较低时，粗化网格适合来包容模型尺寸。 



3.1.6: 命令流 
通过File > Replay菜单的命令流功能可以很容易地解决几何模型参数改变的问题。长度、

宽度和高度等详细的几何特征改变都归于参数的变化，尽管如此，这些改变并不影响拓扑

块，因此，命令流功能可以自动为参数改变的几何体生成一个相似的块模型。 
注意：如果是利用直接的CAD接口，所有的几何参数改变都是通过原来的CAD系统得

到；如果是利用间接的CAD接口，几何参数的改变是通过ICEM DDN得到的。 
生成一个命令流文件： 
生成一个命令流文件首先要激活记录生成初始拓扑块模型的命令流的功能。就像上面提

到的这个功能可以通过File > Replay调用。所有划分网格过程中的命令都被记录下来，包括

块操作、网格尺寸的定义、边的划分、边界条件的设定和最终网格的生成。 
接下来的第二步是改变几何体的参数，然后在变化后的几何上应用已经记录的命令流，

从这时候开始所有的网格生成过程的命令将被自动执行。 
命令流的优点： 
应用命令流，用户可以分析更多的几何变量，以此获得更多关键参数的信息，也可以在

工程任务时间内得到最佳的设计方案。 
3.1.7: 周期（Periodicity） 

在ICEM CFD Hexa中允许定义周期。周期节点定义的功能可以在Blocking > Periodic 
nodes中调用，在分析旋转机械的应用中具有重要作用。典型地，用户可以只为旋转部件中

的一部分建立模型，也可以是对称部件，以此最小化模型尺寸。通过定义进口和出口边界

之间的周期关系，在模型中加入特定的说明——进入一个边界的流动参数必须统一于流出

一个边界的流动参数。 
周期关系的使用：周期关系应用于块的面，保证了在第一个边界的节点有两个和第二个

边界上对应节点同样的坐标。用户被提示顺序选择两个面对应的顶点，当流动边界上所有

对应的顶点都选择后，在边界之间的完整的周期关系就设定好的。 
3.1.8:网格质量 

网格质量检查功能通过Meshing > Quality check调用，以下四种中的任何一种质量检查均

会显示一个图表给用户，来表示结果。 
通过鼠标左键单击柱状图中任何一个柱条，用户都可以确定对应单元在模型中的位置，

这个被选择的柱条也会变成粉红色。 
在选择了柱条后，激活显示按钮就会突出显示相应的单元，如果填充按钮是激活状态，

图中柱条对应的单元机会已固体状态突出显示。 
行列式： 
行列式检查通过计算每一个六面体的雅可比行列式值然后标准化行列式的矩阵来表征

单元的变形。值为1表示理想的六面体立方块而0表示具有负体积的反立方体。网格质量以x
轴表示，所有的单元在0到1间。如果某单元行列式的值为0，这个立方块则有一个或多个退

化的边。通常，行列式的旨在0.3以上可以为大多数求解器接受。 
图中以y轴表征单元的数目，尺度范围从0到柱条高度表示的值，质量的分辨率由定义的

柱条的数目来确定。 
角度： 
角度选项检查每个单元中内角从90度的最大角度背离，各种求解器对内角检查有不同容

忍限度，如果单元是扭曲的，而且内角很小，求解的精度就会下降。有必要每次都以求解



器能够允许的内角极限来检查。 
体积： 
体积检查将计算模型内单元的内体积，显示体积的单位是建造模型时使用的单位。 
扭曲： 
扭曲检查将产生一个图表显示了单元扭曲的程度，彼此在一个平面的节点构成一个小扭

曲的单元，使单元拧弯的节点会增大变形，带来大的扭曲度，柱状图中的y轴度量单元的数

目——由柱条的高度表示。X轴，从最小值0到最大值90表示单元承受的扭曲程度。 
 

4. 三维连接管（hexa使用举例） 
过程简述： 
在这个使用范例中，用户将生成一个三维的管连接头的网格，在检查了第一次的网格后，

再利用O网格生成新的，比较网格质量。 
4.1.1:步骤 

构思建立块结构 
开始工程 
创建各部分 
生成初始块 
针对几何体的块操作 
映射边到曲线 
移动顶点 
检查网格质量 
在块中生成 O 网格 
检查并保存网格 

4.1.2:块构思 
这第一个三维例子的块构思比较简单，将初始的块分割为分别适合两个半圆柱体的两个

主块，将剩余的块体添加在 VORFN 中。最后，利用 O 网格功能提高网格质量。 

 
4.1.3:开始工程 



运行ANSYS ICEM CFD，更改工作地址为CFDHelp/CFD_Tutorial_Files/。打开3DPipe 
Junct 工程，读入几何文件geometry.tin。 
4.1.4:创建部分 

前面的例子在块操作被调用之前，部分就是预先定义好的。但对于接下来的工程，初

始的几何体都是在一个单一的部分里，利用创建部分的功能用户需要将模型的各区域重新

定义为不同的部分。这一个操作按照下面的示例进行。首先如图激活各个选项。

 
面部分： 
在树型 目录中

单击Parts > Create 
Part如图所 示 

弹出一 个创建

部分的菜 单，单

击Create    Part by 
Selection按 钮。 

点击 Choose 
an Item后将 弹出一

个几何选择 菜单，

关闭Points and 
Node 
Selection（点 和节点

选择）、Curves or Line Selection（曲线和线选择）和Volume and Bodies（体选择），激活

Surface and Shell Selection（面选择）如图： 

 
现在是面选择模式，鼠标左键选择最大的半圆柱体，右键确认选择，在窗口里键入部

分的名称：CYL1，点击APPLY接受，这时在树型目录里将出现新的部分如图： 



 
用和以上同样的方法生成面部分CYL2，OUT， INL，SYM，在连续选择模式下将如图

所示的各个面定义在相应的部分里： 

 
曲线部分： 
在选择窗口里关闭Surface and Shell Selection，激活Curves or Line Selection如图： 

 
用鼠标左键矩形框选择所有可见的曲线，中键确认接受选择。 
键入名称CURVE后点击APPLY。  
点部分： 

相似的生成点部分，激活Points and Node Selection，关闭Curves or Line Selection，选择Select 
all appropriate object（选择所有合适的体），如图： 

 
所有的点将被自动选择，然后键入名称POINTS，点击APPLY完成。 
注意：在完成了面、曲线、点部分的创建，用户需要将选择窗口里所有的选择开关激活。  



创建体积点： 

在几何工具栏里选择Geometry > Create Body ，弹出生成体的窗口如图： 

 

 

选择Material Point 接着左键选择如下图所示的两个点，以它们的中点最为体积点，中

键确认。 

 
在弹出的窗口里键入 LIVE 作为部分名称，单击确定。这样就可以使在圆柱体内的区域

从 VORFN 中分离出来。单击取消退出创建体窗口，体积点的名称 LIVE 将在部分目录里出

现。 



在树型目录里右键单击Parts > Delete Empty Parts，空的部分GEOM将被删除。 
在继续工程之前保存更改后的几何文件：File > Geometry > Save Geometry As。 

4.1.5:初始化块结构 
选择Blocking > Create Block > Initialize block>Type 3D。键入LIVE作为部分名称，点击

后键盘点击热键“a”。 
4.1.6:几何块操作 

接下来的一步是分割块为四个子块。首先在树型目录里激活曲线和面。 
为了简化分割过程，选择View > Left（左视）如图： 

 
选择Blocking > Split Block > Split Block，左键选择顶端水平边，试着移动边到需要的位

置（如上图）然后点击中键确定。对垂直的边进行同样的分割操作。 
第二步：如图添加块到部分VORFN。最初的块被分割成四份，然后区别这些块为LIVE和
VORFN。选择Parts > Create Part >VORFN（此项应为关闭状态），弹出修改部分的菜单，

选择Add Block to Part>Choose an Item button，将打开选择块的窗口，单击Select corner 
vertices后通过CYL1上部的两个对角点（如图）选择块，中键接受选择，确认添加块VORFN。 

 



4.1.7:边映射到曲线 

聚合曲线 
选择Blocking > Association > Group curves。在树型目录里关闭面，激活曲线显示。 根

据图选择聚合曲线1、2、3。对曲线4、5，曲线6、7，曲线8、9、10，重复这一过程。 

 
边——曲线的关联 
现在是块的边与合适的曲线对应起来，选择Associate > Associate Edge to Curve。左键选

择对应于曲线C的边中键完成选择（如图）。使选择的边与曲线C关联，点击确认。 
类似的选择曲线1、2、3然后选择与它们对应三个边（为了方便用户可以根据映射关联

图来选择）。 

 
 
注意：因为是在连续选择的模式下，其他所有的映射都可以在一次功能调用中完成。 
建立合适的边与曲线 4、5 和曲线 6、7 之间的关联，如图中 A、B。 
建立曲线 8、9、10 和相对应三个边的关联完成整个操作。 
建立边和曲线 C 的关联。 



4.1.8:移动顶点 
在树型目录里选择Edges > Show Association观察映射关系。 

 
选择Associate > Project Vertices > All Visible后确认。 
如图通过Blocking > Move Vertex > Move Vertex移动顶点到合适的位置。 

 
当所有的顶点移动之后，保存块。 

4.1.9:生成网格 
初始的块完成后，用户可以定义网格参数，应用到选择的当前所有的面。要查看面的参

数，关闭曲线和边，激活面。 
在目录里选择Surface > Hexa size，当前默认的网格参数设置将在每一个面上显示，如下图： 

选择Mesh > Set Surface mesh Size定义网格参数。如图所示在窗口中键入以下参数

Maximum Element Size > 10. Height > 4. Ratio > 1.3。选择所有的面后确认。 



 
注意：初始高度是指表面单元的高度，而高度比指的是从初始高度的增大比。 

当网格参数设置后，点击取消关闭窗口。修改后的参数如图所示，在继续下步操作之间关

闭Surfaces > Hexa Size。 

 
选择Blocking > Pre-Mesh Params > Update Size > Update all 然后点击Apply。 
现在，在树型目录里激活Pre Mesh > Project Faces，在弹出询问是否重新计算网格时单

击确认。 
在目录中关闭面，激活Pre Mesh显示，并选择Pre Mesh > Solid，第一次的网格将显示如

图： 



 
4.1.10:网格质量检查 

在网格生成以后，用户应该进行质量检查。 
角度： 
检查每一个单元的最小内角，各种求解器对内角有着不同的要求，如果单元是扭曲的内

角就小，计算的精度也会下降。有必要弄清楚求解器可以接受的内角极限。 
行列式： 
计算网格单元的行列式，这是一种通过雅可比矩阵来度量体积的方法。等于 1 的值意味

着理想的六面体，等于-1 的值则表示具有负体积完全的反立方体。 
扭曲： 
扭曲检查将产生一个柱状图显示单元扭曲的程度，y轴以柱条的高度代表了单元的数目，

x 轴上的值变化范围从 0 到 1，度量单元体所受的扭曲。 
选择Blocking > Pre Mesh Quality，选择角度为依据准则，将显示如图所示的柱状图： 

 
左键选择其中两个最糟的柱条，如下图显示： 



 
从图表窗口选择show（显示），突出显示选择的范围所代表的单元。在树型目录里关闭

Mesh，激活边和曲线显示，如果有必要也可以关闭Edges > Association，如上图。 
就像图中显示的一样，最糟糕的单元是由于在圆柱体上采用了H型网格带来的，点击

Done关闭图表窗口。 
接下来用户将利用O网格功能，来观察单元质量是否有大的改进。 

4.1.11:在块中生成 O 网格 
为了视图方便，激活边、面和曲线显示。 
在继续之前，注意看所有的定点是否在和上图一样的位置，如果不是，选择Blocking > 

Move Vertex > Move vertex，移动顶点。 
选择Select Blocking > Split Element > O grid，将弹出如下图所示的O网格窗口： 

 
选择所有的块后接着选择部分INL、OUT和SYM的平面（如图）。在选择平面时可以用

Blocks> Select corner vertices，选择图中箭头所示的顶点，这些顶点代表了在部分INL、OUT
和SYM里平面的对角。 
 



单击应用后，O网格块将在块结构中被构造出来，如图： 

 
注意：如果块的结果与上图不一致，用户可以使用撤消功能。 

，选择如图所示的边，

在O
选择Edit Block > Rescale O grid，将弹出重新定义O网格尺寸的菜单

ffset中键入0.5，关闭Absolute后点击应用。 

 
选择Blocking > Pre Mesh Params > Update size，在弹出如图的窗口里选择Update all（更

新全部）后，点击确认。 



 
关闭在打开Pre-Mesh，在弹出的窗口里单击Yes确认重新计算网格。 
生成如下图所示的新网格： 
在树型目录里打开mesh，关闭其他如曲线、面、边的实体显示。 

4.1.12:检查网格并保存 
选择Blocking > Pre Mesh Quality，以角度为检查依据，我们会发现网格质量是高的。 
选择 Blocking > Pre Mesh Quality，以 Determinant2*2*2 为检查依据，将看出这个网格的

质量满足任何一个商用求解器。 
选择 File > Mesh > Load from Blocking，以 hex.uns 保存网格。 
选择 File > Save Blocking 保存块结构，在弹出的窗口中点击 Save，以扩展名 blk 保存块

文件。 
最后，选择File > Exit退出程序。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
附： 



在CFD计算中，网格技术是影响求解精度和速度的重要因素之一，ANSYS ICEM CFD

是一款功能强大的CFD前后处理器，相比同类的商用软件，在网格生成的速度、质量控制、

网格输出接口方面都有很大的优势和潜力。 

利用 Hexa 生成网格最重要的就是分块构想，对于复杂的几何模型，可以有不同的分

块方案，选择一个合适的划分方式直接决定了最终生成的网格质量可以到达的水平。另外，

使用 Hexa 模块生成六面体网格，在划分过程及网格平滑、编辑过程中都不必定义它的结构

类型，在最终确定网格以后，可以选择将其作为结构或者非结构网格输出给求解器。结构

六面体网格对每一个分块区域都将产生一个分区文件（domain.n），而非结构网格所有的节

点信息只包含在一个文件中。 

众多的用户认为ANSYS ICEM CFD的四面体网格划分工具Tetra是其做得最好的一个

工具模块。它可以直接对 CAD 模型或者 STL 生成四面体网格而不需要先生成表面三角形

网格，其内部网格与表面拓扑独立，并能很好的匹配事先规定的用来表达几何形状的关键

点和曲线。Tetra 定义自然尺寸决定各个几何特征上四面体网格尺寸，并可单独针对每一个

材料点区域进行粗化或者细化计算。在模型数据输入以后，Tetra 根据读入的曲线和曲面用

线段和三角形进行近似，并将预先定义的点设为网格顶点，当在表面存在间断但没有曲线

定义，Tetra 划分的三角形会自由越过这个间断，而预先定义的点会使它辨认出曲线上尖锐

的拐弯，并且 Tetra 中的模型检查工具可以自动在尖锐的几何特征上获得点和曲线。此外，

对于已有的三角形表面网格，Tetra 可以根据其生成四面体网格，尽管生成的网格节点并不

和原始的网格节点完全重合，但是通过三角形表面网格它可自动识别关键点和曲线，从而

使网格符合几何模型的形状，这对于从别的网格数据或者立体扫描数据中导入模型是很有

用处的。 

ICEM CFD Tetra 生成四面体网格的空间划分是基于八叉树算法（8-Octree），这种算法

保证了需要的区域有足够的网格密度，但是为了快速计算生成网格，首先构造一个初始的

网格来包围整个几何模型，然后单元会被不断的细分 达

到定义的最大网格尺 寸

（如图 2.7 所示），每 个

维的尺寸按照二分之 一



分割，对于三维就是八分之一，再通过节点调整以匹配几何特征点和曲线（如图 2.8 所示），

剔除材料体外的网格单元后进一步通过单元细化、节点移动、合并、交换和删除来平滑网

格使其年达到最终质量要求，        图 2.7 曲线定义的最大尺寸和细分后的初始网格 

如图 2.9 所示： 

 

  图 2.8 匹配几何模型后的网格                        图 2.9 最终的网格 

图 2.10 所示是一个活塞阀模型利用 Tetra 划分 

的网格（包括三十万四面体单元），在上部的弯管之间有

一个细阀管，其连接固定处设置为稠密区来自动加密网

格。 

使用 Tetra 划分四面体网格的基本过程比较简单，

生成网格速度快，能够容忍几何模型的不完善，在初始

的网格形成以后，可以通过编辑功能来自动修改重复单

元 等 错 误 ， 利 用 平 滑 功 能 提 高 网 格 质 量 。            

图 2.10 活塞阀的四面体网格      

2.3.3 其他网格工具 

ICEM CFD Prism 是三棱柱网格工具，主要是用于在四面体网格的基础上快速生成三

棱柱边界层网格。 

ICEM CFD Hybrid 是指可以生成四面体和六面体混合网格，在连接处采用金字塔形的

单元。 

ICEM CFD Quad 用于生成四边形表面网格，可以通过简单的拉伸得到非结构六面体网



格。 

ICEM CFD Global 与 ICEM CFD Autohexa 分别是自动笛卡儿网格和自动六面体网格工

具，由于本文使用的软件版本中没有相应的模块，所以不做说明，其中关于 Autohexa，一

些相关的资料表明没有什么工程实用价值，只能对复杂程度很低的模型生成网格。 

2.3.4 ANSYS ICEM CFD 的工程及其包含文件 

ICEM CFD 在打开或者创建一个工程时，总是读入一个扩展名为 prj（project）的文件，

即工程文件，其中包含了该工程的基本信息，包括工程状态及相关子文件的信息。  

一个工程的可能包含的子文件如下（以“name”代表文件名）： 

name.tin（tetin）文件：几何模型文件，在其中可以包含网格尺寸定义的信息； 

name.blk（blocking）文件：六面体网格拓扑块文件； 

domain.n 文件：结构六面体网格分区文件，n 表示分区序号； 

name.uns（unstructured）文件：非结构网格文件； 

multi-block 文件：结构六面体网格文件，包含各个分区的链接信息，在输出网格用它

来链接各个网格分区文件。 

name.jrf 文件：操作过程的记录文件，但不同于命令记录。 

family.boco（boundary condition）、boco 和 name.fbc 文件：边界条件文件； 

family_topo 和 top_mulcad_out.top 文件：结构六面体网格的拓扑定义文件。 

name.rpl（replay）文件：命令流文件。记录 ANSYS ICEM CFD 的操作命令码，可以

通过修改或编写后导入软件，自动执行相应的操作命令。对于已经划分网格的模型，当其

几何参数发生改变，而几何元素的名称及所属的族名称没有发生变化，就可以通过读入命

令流文件重新执行所有命令，从而很方便的再生成网格，利用这个功能通过记录一个模型

网格划分的命令流而建立这类模型的操作模块将会节省大量时间（前提是这一类的模型在

几何形状上不能有太大的差别，因为并不能保证同一种拓扑分块方案会适合所有仅仅是“貌

似”的模型）。 

 
 

（完于2005年7月） 
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